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Abstract  
  
An earthquake is a phenomenon of ground motion caused by the sudden breaking and movement of large sections 
(tectonic plates) of the earth’s rocky outermost crust. If an earthquake occurs in a populated area, it may cause many 
deaths and injuries and extensive property damage. Although there are no guarantees of safety during an 
earthquake, it is difficult identifying the potential hazards ahead of time and advance planning to save lives and 
significantly reduce injuries and property damage. Hence it is mandatory to do seismic analysis to the structure 
against collapse. In this paper an attempt is made to understand the performance of R.C building frame structure in 
plain and sloping ground when subjected to gravity and earthquake load. To understand this four three dimensional 
seven-storied (G+6) reinforced concrete building are consider in which the first frame is positioned at zero degree 
with respect to the horizontal ground and remaining three frames are placed at 10, 20 and 30 degrees respectively. 
All the four frames are modelled and analyzed using SAP2000 software. The Equivalent Static Method as per IS:1893-
2002 is used to analyze all the modelled manually. The performance of the structure is assessed by comparing the 
Shear Force, Bending Moment and deflection in different frames. Also, the base shear of different frames obtained 
manually is compared with the SAP 2000 results. 
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1. Introduction 
 
Earthquake is considered as a catastrophic natural 
disaster. Many people die every year due to collapse of 
buildings due to earthquakes. The most recent example 
is the Ecuador earthquake of 7.8 magnitude on richer 
scale which struck on 16th April 2016. It killed more 
than 650 people with buildings collapsing hundreds of 
kilometers from the epi-center of earthquake. The 
damage to structures can be reduced by adopting 
principles of earthquake resistant designs. 
 This project shows an analysis of G+6 storey 
residential building by seismic analysis (with dead, live 
and earthquake loads). Seismic response of a structure 
can be obtained by using linear, non-linear analysis. 
Various methods of seismic analysis include (i) 
Equivalent Static Analysis, (ii) Response Spectrum 
Analysis, (iii) Linear Dynamic Analysis, (iv) Non-linear 
Dynamic Analysis. 
 This project employs Equivalent Static Analysis to 
obtain seismic response of G+6 storey residential 
building. All these G+6 storey residential building are 
od zero degree, 10 degree, 20 degree and 30 degree. 
 As per IS 1893 (2002) code, five types of 
irregularities for buildings are stiffness irregularity, 

Weight (Mass) Irregularity, Vertical geometric 
irregularity, In-plane Discontinuity in capacity. 
a) Stiffness Irregularity- Soft Storey: is defined to exist 
when there is a storey in which the lateral stiffness is 
less than 70% of that in the story above or less than 
80% of the average stiffness of the three stories above. 
b) Stiffness Irregularity – Extreme Soft Storey: is 
defined to exist where there is a storey in which the 

lateral stiffness is less than 60% of that in the storey 
above or less than 70% of the average stiffness of the 
three stories above. 

Weight (Mass) Irregularity- It is considered to exist 

where the effective mass of any storey is more than 

150% of the effective mass of an adjacent storey. 

Vertical geometric irregularity – It shall be 

considered to exist where the horizontal dimension of 

the lateral force- resisting system in any storey in any 

storey is more than 130% of that in an adjacent storey. 

In-plane Discontinuity – In Vertical Lateral-Force-

Resisting Elements is defined to exist where an in-

plane offset of the lateral-force-resisting elements is 

greater than the length of those elements or where 

there is a reduction in stiffness of the resisting element 

in the storey below. 
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Discontinuity in Capacity – The weak storey is one in 
which the storey lateral strength is less than 80% of 
the in the above storey. The storey lateral strength is 
the total lateral strength of all seismic-resisting 
elements sharing the storey shear in the consideration 
direction. 
 
2. Structural Modelling 
 
2.1 GENERAL 
 
The study in this thesis is based on linear analysis of a 
structural model subjected to gravity and earthquake 
load. The buildings are designed according to IS: 
1893(part I): 2002and analysis by SAP2000 v21, which 
is a structural analysis program for static and dynamic 
analysis of structures. 
 
2.2 GEOMETRY OF BUILDING: 
 

Table 1   Geometry of zero-degree structure 
 

TYPE 
OF 

BUIDIN
G 

MEMBE
R 

FLOO
R 

WIDT
H 

(mm) 

DEPT
H 

(mm) 

REINFORCEME
NT 

Zero-
degree 

structur
e 

 
Column 

1 to3 450 450 #8-28d 
4 to 6 350 350 #8-20d 

7 300 300 #8-16d 
Beam 1 to 7 300 300 #8-16d 

 
Table 2   Geometry of 10-degree structure 

 
TYPE 

OF 
BUIDIN

G 

MEMBE
R 

FLOO
R 

WIDT
H 

(mm) 

DEPT
H 

(mm) 

REINFORCEME
NT 

10-
degree 

structur
e 

Column 
1 to 3 500 500 #12-28d 
4 to 6 450 450 #8-20d 

7 400 400 #8-16d 
Beam 1 to 7 300 300 #8-16d 

 
Table 3   Geometry of 20-degree structure 

 
TYPE 

OF 
BUIDIN

G 

MEMBE
R 

FLOO
R 

WIDT
H 

(mm) 

DEPT
H 

(mm) 

REINFORCEME
NT 

20-
degree 

structur
e 

Column 
1 to 3 500 500 #12-28d 
4 to 6 450 450 #8-20d 

7 400 400 #8-16d 
Beam 1 to 7 300 300 #8-16d 

 
Table 4   Geometry of 30-degree structure 

 
TYPE 

OF 
BUIDIN

G 

MEMBE
R 

FLOO
R 

WIDT
H 

(mm) 

DEPT
H 

(mm) 

REINFORCEME
NT 

30-
degree 

structur
e 

Column 
1 o 5 550 550 #12-36d 
6 to 7 500 500 #8-28d 

Beam 1 to 7 300 300 #8-16d 

 
2.3 MATERIAL PROPERIES: 

Material properties are assumed as 25MPa for concrete 
compressive strength and 415Mpa for yield strength of 
reinforcing steel for all the models used in the study. 
Elastic properties of these materials are taken as per 
Indian standard IS: 456- 2000. 
 The short-term modulus of elasticity (Ec) of 
concrete is taken as: 

   EC = 5000√𝒇𝒄𝒌 MPa 

Where, fck is the characteristic compressive strength of 
concrete cube in MPa at 28th day. For the steel rebar, 
yield stress(fy) and modulus of elasticity (Es) are taken 
as per IS: 456-2000. 
 
2.4 STRUCTURAL ELEMENTS: 
 
The structural system of the building is considered as 
space frames having 3- dimensional frame elements 
representing beams and columns and shell elements 
are used for slabs. The columns are fixed at the base of 
the foundation level and floor slabs are assumed to act 
as diaphragm. The beam-column joints are assumed to 
be rigid and hence modelled by giving end-offsets to 
the frame elements with rigid zone factor 1, so as to 
obtain the bending moments and forces at the beam 
and column faces. Soil- structure interaction and P-
delta effects are not considered for the analysis. The 
buildings are considered as ordinary moment resistant 
frame (OMRF) buildings situated in seismic zone V and 
medium type of soil is considered with 5% damping. 
The floor diaphragms are considered as rigid in their 
plane and each nodal point in the frame has six degrees 
of freedom, three translations and three rotations the 
material properties and structural components are 
tabularized on Table 5. 
 

Table 5 Material properties and structural 
components of the structures 

 
Property / Structural 

component 
Value 

Yield strength of steel, fy 500 Mpa 
Compressive strength of 

concrete, fck 
45 Mpa 

Modulus of elasticity of steel. Es 200000 Mpa 
Modulus of elasticity of concrete, 

Ec 
22360.67 Mpa 

Unit weight of concrete 25 KN/m3 
Slab Thickness 125 mm 

           
3. SAP2000 
 

SAP2000 is general-purpose civil-engineering 
software ideal for the analysis and design of any type of 
structural system. Basic and advanced systems, 
ranging from 2D to 3D, of simple geometry to complex, 
may be modelled, analyzed, designed, and optimized 
using a practical and intuitive object-based modelling 
environment that simplifies and streamlines the 
engineering process. The SAP Fire ® Analysis Engine 
integral to SAP2000 drives a sophisticated finite-
element analysis procedure. An additional suite of 
advanced analysis features is available to users 
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engaging state-of-the-art practice with nonlinear and 
dynamic consideration. Created by engineers for 
effective engineering, SAP2000 is the ideal software 
tool for users of any experience level, designing any 
structural system.  

First the layout of the frame was established in SAP 
2000 followed by the defining the materials and 
material properties and construction of te members in 
the structure. After this the loads are assigned in the 
respective members and areas and all the joints are 
constrains in z- direction. After this all the members, 
beam and column are rigidly fixed with rigidity zone 
factor 1. The floor diaphragms are considered as rigid 
in their plane and each nodal point in the frame has six 
degrees of freedom. Three translations and three 
rotations. After assigning all the factors mentioned 
above the frame is ready for the analysis.  
 
3.1 Loading in SAP2000: 

  
The dead load of the structure in SAP2000 is calculated 
automatically when there is assigning of any member 
of the structure. To add live load of the structure, one 
has to calculate the live load coming in the structure 
and has to enter the load values manually 
corresponding to its load type and assign to the 
member. For the present study total eleven different 
loads are chosen which is given in the table 7. The 
entire load chosen has to assign one by one in the 
structure. 
 

Table 6 Loads used and their magnitude 
 

SL. NO TYPE OF LOAD MAGNITUDE 

1. Dead load 
Automatic calculated by 

SAP2000 

2. Floor Live 4 KN/m2 

3. Roof Live 2 KN/m2 

4. Floor Finish 0.28 KN/m2 

5. Ceiling Finish 0.2 KN/m2 

6. Roof Finish 0.1 KN/m2 

7. External Partition Load 15 KN/m 

8. Internal Partition Load 7.5 KN/m 

9. 
Earthquake load in x- 

direction 
IS:1893 -2002 

10. 
Earthquake load in y- 

direction 
IS: 1893- 2002 

 
Few loading patterns on the frames are shown in the 
below given figures done in the SAP2000 v21 
  
Figure 3.5: : (a) External wall loading on the frame (b) 
Interior wall loading on the frame & (c) Live loading on 
the Floor of structure. 
 
4.  Analysis of the building 

A step-by-step procedure for the analysis of the frame 
by equivalent static lateral force method is as follows: 

4.1 Calculating using Equivalent static lateral force 
method: 
 
STEP 1: Calculation of Lumped Masses to Various Floor 
Levels: 
 At every level the mass is calculated such as: 

1. Mass of columns: 
I) Weight of the column in first half= No. of 

columns x D x W x H x Unit weight of 
concrete 

II) Weight of the column in second half = No. of 
columns x D x W x H x Unit weight of 
concrete 

2. Mass of beams = L x D x W x Unit weight of 
concrete 

3. Mass od slab = Slab area x D x Unit weight of 
concrete 

4. Mass of Walls = Thickness x Height x L x Unit 
weight of wall 

5. Floor live load = Total area x Floor live load x 
% of floor live load 

6. Floor finish = Total area x Finish load 
7. Ceiling load = Total load x ceiling finish 
8. Roof Live load = Total area x Roof live load x % 

Roof live load 
9. Roof finish = Total area x Roof finish 
Total Seismic load = 1 +2 +3+ 4 +5 +6 +7 +8 +9 

Height h1= 1.75m 
Height h2= 5.25m 
Height h3= 8.75m 
Height h4= 12.25m 
Height h5= 15.75m 
Height h6= 19.25m 
Height h7= 22.75m 
STEP 2: Determination of Fundamental Natural 
Period: The approximate fundamental natural period 
of a vibration (Ta), in seconds, of a moment resisting 
frame building without brick infill panels may be 
estimated by the empirical expression  
  
 

0.75 0.750.075( ) 0.075(22.75) 0.7812aT h s= = =  

Where h is the height of the building, in meters. 
 
STEP 3: Determination of Design Base Shear 
Design seismic base shear, VB = Ah W 

   
0.24 1

(1.740) 0.0417
2 2 5

a
h

SZ I
A

R g
= = =  

For 
1.36

0.7812 1.740a
a

a

S
T

g T
=  = = , for medium 

soil from Figure 2 of IS 1893 (Part 1): 2002  
Design seismic base shear,  
VB = 0.041778 x 46101.33 = 1926.044 kN 
 

STEP 4: Vertical Distribution of Base Shear 
The design base shear (VB) computed shall be 
distributed along the height of the building as per the 
expression, 

https://wiki.csiamerica.com/display/kb/Nonlinear
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3.2 ANALYSIS OF FRAME IN SAP2000: 
 

The first step is to open the SAP2000 V.20 and create a 
new file. To create new file, go to File > New Model. 
Then a popup window appears and select the suitable 
template such as Grid only for this case and initialize 
the model with units such as KN, m, C. Now another 
popup window appears for the grid lines specifications. 
After giving all the required specifications the model is 
created. Now the next step is to define the material 
properties for that go to Define > materials in that 
define the concrete and steel properties. Define > 
section properties > frame sections and define the 
columns and beams. Define > Area sections and define 
the slab. Draw > Draw Frame/cable/tendon and draw 
all the columns and beams. Draw > Draw quick area 
sections and draw the slabs. Assign > Joints > 
Restraints as support. Define > Load cases. Define > 
Load combinations. Assign > Frame loads > 
Distributed. Assign > Area loads > uniform to shell. 
Define > mass source. Now analyse the structure. 
Specify the design code to be used through the Design 
> concrete Frame Design > View/Revise Preferences 
menu. Review the load combinations that will be used 
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for design, making changes if necessary, through the 
Design > concrete Frame Design > Select Design 
Combos menu. Run the design by selecting the Design > 
concrete Frame Design > Start Design/Check of 
Structure option. Please note that analysis must be run 
prior to design. Review the design results either 
graphically, by right-clicking on a member for more 
detailed information, or in tabular format by selecting 
the Display > Show Tables > Design Data option.  
 
4. Performance of the structure 
 
The thesis addresses multi-storey reinforced concrete 
(R/C) frame buildings of regular, irregular and vertical 
irregular in elevation subjected to seismic and without 
seismic force. The buildings are designed as per IS: 
1893(Part I): 2002 considering soil type-2. Analysis is 
performed on both the buildings and variation in 
response qualities such as; Shear force, bending 
moments, Displacement and Axial force in different 
structural element have been assessed. 
 

 
 

VARIATION IN BASE SHEAR 

 
Regular (0 

Degree) 
10 Degrees 20 Degrees 30 Degrees 

X Y X Y X Y X Y 
SAP 

resul
ts in 
kN 

778.
46 

778.
46 

875.
35 

840.
10 

970.
91 

909.
75 

1060
.85 

948.
02 

Man
ual 

resul
ts in 
kN 

1926.044 1810.84 1726.643 1621.079 

 

Time period 

Structure 
Manual calculations 

(in secs) 
SAP2000 (in 

secs) 
Regular (0 Degree) 

0.7812 

1.808 
10 Degree 1.573 
20 Degree 1.336 
30 Degree 0.799 

 
Conclusion 
 
The three dimensional frame of regular zero-degree, 
10-degree, 20-degree and 30-degree sloped building 
analyses have been performed to evaluate the 
performance of RC structural models with seismic 
loading as per the provisions of IS: 1893(part I)- 2002 
and IS: 456-2000 and based on that work the following 
conclusions can be drawn: 
The maximum shear force is experienced by the lower 
or bottom storey columns. As the slope of the ground is 
increasing the shear force of the structure is increasing. 
By the comparison of regular zero-degree structure 
with the 30-degree sloped structure it is observed that 
the shear force is increased by 81.513% in X direction 
and 78.865% in Y direction respectively. 
As the slope of the ground is increasing the bending 
moment of the structure is increasing. By the 
comparison of regular zero-degree structure with the 
30-degree sloped structure it is observed that the 
bending moment is increased by 60.401% in X 
direction and 59.032% in Y direction respectively. 
The maximum displacement will occur at the roof level. 
As the slope of the ground is increasing the deflection 
of the structure is increasing. By the comparison of 
regular zero-degree structure with the 30-degree 
sloped structure it is observed that the deflection is 
increased by 62.038% in X direction and 62.154% in Y 
direction respectively. 
The maximum axial force is at bottom storey. As the 
slope of the ground is increasing the axial force is 
increasing. By the comparison of regular zero-degree 
structure with the 30-degree sloped structure it is 
observed that the axial force is increased by 47.541% 
in X direction and 45.185% in Y direction respectively. 
As the slope of the ground is increasing the time period 
of the structure is decreasing. By the comparison of 
regular zero-degree structure with the 30-degree 
sloped structure it is observed that the time period is 
decreased by 55.807%. 
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